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Overview  
This document describes how to install integrate the SoundScope Audio Server  
into a Crestron control system installation.  This guide assumes that you have setup the 
Media Server and can communicate with it remotely from other PCs on the network using the 
Remote Configuration Interface, or the SoundScope client application  
 
For instructions on setting up the SoundScope Audio Server, please refer to the  
SoundScope Audio Server Setup Guide document.   
 
The MMS and the associated Crestron module offer a ready-to-use solution for IP control of 
your server including browsing local content and internet radio services such as Pandora, 
RadioTime, and Sirius XM radio.  The control service allows the Crestron Control System to 
interactively access functionality and will display feedback for 
those actions.  You can browse your digital media collection, initiate playback, and manage 
the playback queue without having direct access to the Media  display. 
 
In addition to the Crestron control module, the SoundScope Audio Server can be controlled 
via its internal web server using SoundScopes’ desktop client application  , or the 
iPhone application, which is available in the iTunes App Store.  
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Getting Ready. 

Requirements. 
The Audio Control Server module requires a Crestron 2 series processor.  In order to browse 
music by album cover and see now playing graphics, your touch panel must be capable of 
displaying dynamic graphics.  Visit www.crestron.com to determine which touch panels 
support this feature. 
 
If your touch panel does not support dynamic graphics, you can still use Audio Control 
Server, however, only text information will be available.  

Preparation. 
Download the Crestron control module from .  The 
control module downloads with VT-Pro-e touch-panel layouts for X-Panel at common 
Crestron touch panel resolutions.  These layouts are compatible with any Crestron touch panel 
which supports dynamic graphics.  The pages can be copied directly into your touch panel 
project. 
 
Once you have downloaded the control module and required touch panel files, un-zip the files 
into a new directory on your hard drive. 
 
You will find the following files:  
 

1. SoundScope MCS Sample  v2.5.smw.  This is a complete sample program 
which uses the SoundScope MCS module and touch panel files.  

2. SoundScope MCS v2.5.umc.  This is the SoundScope MCS Crestron 
control module.  This file may be placed in the project directory, or in your SIMPL 
user modules directory. 

3. SoundScope MCS IP Processor  v2.5.usp.  This is the SoundScope 
SIMPL+ module which is responsible for IP communications with the server.  This 
file may be left in the project directory, or in your SIMPL user SIMPL+ modules 
directory. 

4. SoundScope MCS X-Panel 800x600 v2.5.vtp. VT-Pro-e X-panel project.  In 
addition to using this interface as a PC client, it is also useful for testing purposes and 
for copying to Crestron existing touch panel projects of matching resolution. 

Programming the Crestron Control System. 
In order to verify that the MCS server application is operating properly and to reduce the 
number of variables during your first run through, SoundScope strongly recommends 
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that you run the included sample program stand-alone on your Crestron processor and touch 
panel before integrating the system into your projects. 
 
The first step is to open the SoundScope MCS Sample program in SIMPL and modify 
the required parameters for your network and Media server. 
 

Changing the processor type. 
In SIMPL, open System View by clicking on the configure icon in the toolbar.  
 

 
 
The sample program assumes a Crestron Pro-2 processor.  Change the processor type if 
necessary by right clicking on the processor in the system tree, and select Replace Processor. 
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Configuring the Media Server IP address. 
Expand the Ethernet card device in the system tree (in this case, C2ENET-1).  Double click 
on IP-ID 04 and change the IP address to match the address or host name of SoundScope 
Audio Server. 
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Configuring the IP Communications Port Number. 

other.  By default, MCS uses port 5004 for IP command protocol communications and 
feedback.   
 
In SIMPL, switch back to Program view.  Open the program tree and select the Ethernet slot, 
and then open the TCP/IP Client symbol configured for MCS. 
 
Change the Port to 5004. 
 

 
 

 
 Tip.  If you changed the default control port in the Mirage configuration tool to 

something other than 5004, change the Port parameter to match. 
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Configuring the SoundScope Module.  
 
INPUTS Type  
IP_Connect Digital Initiates TCP/IP connection while signal is high.   

(High/1: Connect, Low/0:  Disconnect (Level 
Sensitive)) 

Command$ Serial Input for direct command strings to MCS 
RX$ Serial Receive serial data from TCP/IP client 
Status Analog Analog status input from TCP/IP client 
Events_Enabled Digital Enables asynchronous messages from server to 

TCP/IP client.  High/1:  Enable, Low/0:  Disable 
(Level Sensitive) 

Browse_* Digital Initiates browse command for media types 
(determined by context) on a rising edge. 

Browse_Queue Digital Initiates browsing the playback queue on a rising 
edge. 

CurrentList_AddQueue Digital Adds the currently listed media to the playback 
queue on a rising edge. 

CurrentList_PlayNow Digital Adds the currently listed media to the playback 
queue and begins playback immediately on a rising 
edge. 

Play/Pause Digital Play pause toggle. 
Play Digital Discrete play command. 
Record Digital Discrete record command.. 
Pause Digital Discrete pause. 
Stop Digital Discrete stop. 
Skip_Next Digital Advance to next track in queue. 
Skip_Prev Digital Advance to previous track in queue. 
Rewind Digital Rewind currently playing media 
FastForward Digital Forward through currently playing media 
Browse_Instances Digital Initiates browsing of sources configured in MCS on 

rising edge. 
Shuffle_Toggle Digital Toggle Shuffle on and off on a rising edge. 
Repeat_Toggle Digital Toggle Repeat on and off on a rising edge. 
PageFlip_*_From_TP Digital Receives page flip presses from interface and 

executes page logic on a rising edge. 
PageFlip_KB Digital Displays the keyboard on a rising edge. 
PageFlip_KB_Off Digital Suppresses the keyboard on a rising edge. 
SavePlaylist Digital Discrete command to Save the current queue as a 
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playlist.  Function also available via contextual 
buttons. 

Search Digital Discrete command to search currently browsed 
media.  Function also available via contextual 
buttons. 

Clear_Queue Digital Discrete command to remove all songs from the 
playback queue and stop playback.  Function also 
available via contextual buttons. 

Zones Digital Discrete command to initiate browsing of zones 
available to MCS.  Function also available via 
contextual buttons.- 

Actions Digital Discrete command to bring up action list for 
currently playing media.  Function also available via 
contextual buttons. 

Scrollbar_Position Analog Send an analog value (0-65535) to scroll through list 
of media. 

Direct_Volume Analog Set the volume of current instance directly (0-50) 
Previous_Page Digital Browse previous number of list items. 
Next_Page Digital Browse next number of list items. 
Go_Back Digital Initiate last browse command in browse history. 
Home Digital Browse to top of list 
End Digital Browse to end of list 
Volume_Up Digital Increment volume of current instance 
Volume_Down Digital Decrement volume of current instance 
Mute_Toggle Digital Toggle between mute on and off for current 

instance. 
Thumbs_Up Digital Pandora Thumbs Up function. 
Thumbs_Down Digital Pandora Thumbs Down function. 
Dialog_Button_* Digital Select buttons for user prompts from interface. 
Art_Error_Monitor_* Analog 

for list items.  Tracks value of analog and re-
 

Title_Select_* Digital Pulse to select the corresponding title in a list. 
Title_AddToPlaylist_* Digital Pulse to select the corresponding title in a list and 

add to the playback queue. 
Title_PlayNow_* Digital Pulse to select the corresponding title in a list and 

play back title immediately. 
Alpha_Search_Up Digital Jump to first letter feature:  scroll down alphabet. 
Alpha_Search_Down Digital Jump to first letter feature:  scroll up alphabet. 
Context_Button_* Digital Pulse to send command for contextual buttons.  

Buttons 1-4 are multi-function based on current state 
of MCS.  
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Button 1:  Actions when on Now Playing page, 
PageFlip to Now Playing page when not on the Now 
Playing page, blank if on Now Playing page but no 
media is playing. 
 
Button 2:  Save Playlist when browsing the Queue 
and there is media in the Queue, blank when 
browsing the Queue but the queue is empty, 
otherwise Zones. 
 
Button 3:  Search when browsing media that is 
searchable,  Clear Queue when on Now Playing or 
Browsing the Queue, otherwise blank. 
 
Button 4:  Controls when not on the Remote page, 
otherwise blank. 

Enable_Debugging Digital Outputs verbose debugging messages to the text 
console while high.  High/1 Enable, Low/0 Disable 
(level sensitive) 

 
 
 
 
 
 
 
 
OUTPUTS Type  
Connect Digital Connection signal to TCP/IP Connect input.   
IP_Status_Text$ Serial TCP/IP Client connection status message. 
List_Position$ Serial Outputs current position in a list. 
List_Caption$ Serial Outputs title of currently browsed list. 
TrackLength_fb$ Serial Length in minutes:seconds of the currently 

playing track. 
TrackTime_fb$ Serial Progress in minutes:seconds of the currently 

playing track. 
TrackNumber_fb$ Serial The number of the currently playing track in the 

playback queue. 
Current_Media_Type Analog Analog value indicating the type of media that is 

currently being browsed. 
Browse_Buttons_Mode Analog Analog value that determines the format of the 
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browse buttons based on the MCS Configuration.  
0 = Windows Media Center, 1 = Windows Media 
Player and iTunes (music only) 

Button_State Analog Analog value that determines the state of 
contextual buttons. 

Transport_fb Analog Feedback for the current state of the transport.  0 
= Stop, 1 = Play, 2 = Pause, 3 = Forward, 4 = 
Rewind. 

Record_fb Analog Feedback for record status.  1 = Recording, 0 = 
not recording. 

Current_Track_Progress_fb Analog Progress of the currently playing media in an 
analog value (0-65535).  For use with a gauge or 
slider. 

Shuffle_fb Analog Feedback for state of Shuffle mode.  0 = off, 1 = 
on. 

Repeat_fb Analog Feedback for state of Repeat mode.  0 = off, 1 =  
on 

PageFlip_*_To_TP Digital Signals to drive appropriate subpages on 
interface. 

D_Pad Digital Signal to drive D_Pad subpage (for smaller 
format panels) 

Num_Pad Digital Signal to drive Num Pad subpage (for smaller 
format panels) 

Search_Enabled Digital High/1 if currently browsed media is searchable 
Alpha_Enabled Digital High/1 if currently browsed media is searchable 

by first letter 
Chapters_Button Digital High/1 if current movie title has chapters 

available 
Dialog_Enabled Digital High/1 if MCS requires a dialog box for user 

input. 
Actions_Enabled Digital High/1 currently playing media has actions 

associated with it. 
Prev_Enabled Digital In list browsing = 1 if there is previous media in 

the list.  Use to enable/disable Previous page 
button on interface. 

Next_Enabled Digital In list browsing = 1 if there is more media in the 
list.  Use to enable/disable Next page button on 
interface. 

Back_Enabled Digital High/1 if there is browse commands available in 
browse history.  Use to enable/disable Back 
button on interface. 

Scroll_Enabled Digital High/1 if list contains more items than number 
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that can be displayed.  Use to enable/disable 
scrollbar, Next/Prev page buttons on interface. 

ThumbsUp_Enabled Analog Equals 1 if Thumbs Up button available (for 
Pandora). 

ThumbsDown_Enabled Analog Equals 1 if Thumbs Down button available (for 
Pandora) 

Scrollbar_fb Analog Value for current position in list. 
Volume_fb_Scaled Analog Volume level for current instance (0-50). 
Mute_fb Analog Feedback for current mute status.  1 = Muted, 0 = 

unMuted. 
Now_Playing_Art$ Serial URL for Now Playing Artwork.  Connect to 

dynamic graphics join.  Angled artwork with 
reflection. 

Now_Playing_Art_Small$ Serial URL for smaller size Now Playing Artwork.  Use 
for smaller resolution panels.  Angled artwork 
with reflection. 

Now_Playing_Thumb$ Serial URL for Now Playing Artwork.  Use for smaller 
resolution files.  Flat artwork no reflection. 

Now_Playing_Thumb_Full$ Serial URL for Now Playing Artwork.  Uses 
height/width parameters in module parameters.  
Flat artwork no reflection. 

Browse_Art$ Serial URL for details artwork. 
MCS_Browse_Art_Format Analog Determines format of artwork for details. 
MetaData*$ Serial Contextual media meta data for currently playing 

media. 
MetaLabel*$ Serial Contextual meta data labels for currently playing 

media. 
MediaInfo*$ Serial Contextual information data on currently playing 

media. 
Dialog_Buttons Analog Outputs number of dialog buttons needed to be 

displayed by MCS. 
Dialog_Caption$ Serial Title of Dialog box. 
Dialog_Text$ Serial Instructions for Dialog box. 
Dialog_Defualt_Text$ Serial Text to display in text field by default when 

dialog with keyboard entry is invoked. 
Button_Text_*$ Serial Labels for each of 3 dialog box response buttons. 
List_AlbumArt_*$ Serial URL for artwork for corresponding list item. 
Title_Enable_* Analog Feedback if particular list field is enabled. (1 

enable list field to display media, 0 disable list 
field to reflect no media ie.  At end of list). 

Title_Text_*$ Serial Text to display for each corresponding list item. 
List_SubText_*$ Serial Sub Text to display for each corresponding list 
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item. 
Display_Alpha_Index Digital Drives search by first letter display when used. 
Alpha_Index_Letter$ Serial Feedback showing current letter when searching 

by first letter. 
Context_Button_*$ Serial Text label for contextual buttons.  Output of each 

corresponding signal reflects function as outlined 
in the Inputs section. 

Refresh Digital Pulsed high when MCS requires a touchpanel 
refresh.  Connect to an Ethernet Offline Manager 
refresh input or Poll Manager update request for 
an interface. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The SoundScope Modules has six configurable parameters. 
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ListItems  This tells the module how many list items appear in your VT-Pro project.  If you 
modify the included interface files, set this parameter to the number of text list items in your 
project.  This value does not need to be changed for the sample program. 
 
Thumbnails  This parameter specifies how many thumbnails appear in your VT-Pro project. 
If you modify the included interface files, set this parameter to the number of thumbnail list 
items in your project.  This value does not need to be changed for the sample program. 
 
Art-Server  This is the full address of the SoundScope web server which is 
responsible for serving album art to the touch panel.  This is the same as your server IP 
address. 
 
Default Instance  The is the name of the output that this module will control.  Available 
values are, Main, Player_A, Player_B, Player_C, and Player_D. 

Now Playing Art Height & Width  This allows you to adjust the size of the now playing art 
to maximize picture quality for various size/resolution touch panels. These dimensions should 
match the size of the Now Playing dynamic graphics object in your project for best results. 
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Configure your touch panels. 
If you are going to test MCS with a physical touch panel, configure the touch panel normally 
in SIMPL and copy the digital, analog, and serial joins from the X-Panel symbol in the 
sample project. 
 
Additionally, you will have to provide logic that drives the Connect input on the SoundScope 
module high when the touch panel is online.  For testing purposes,  it is acceptable to 

 
 
If you are going to test the system with an X-Panel application, you do not need to make any 
further changes. 
 
 

 If you have followed all the steps up to this point, the program is now ready to be 
uploaded to the processor.   
 
See the next page for setup instructions for the touch panel project. 
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Configuring the VT-Pro files. 
This guide will help you configure the X-Panel projects for EXE or Web browser 
consumption.  If you are setting up a physical touch panel, no additional configuration is 
necessary, simply upload the project to the touch panel. 
 
Open the VT-Pro-e file suitable for your application. 
 
The first step is to choose your compile options.  If you are using Microsoft Vista, compiling 
as an EXE is recommended since X-Panel browser projects are not compatible with Windows 
Vista. 
 
Select the Edit menu, then click on Properties. 
 
 

 
 

 
Set your target platform, and make sure the output is set for Release mode. 
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Configuring the VT-Pro files. 
This guide will help you configure the X-Panel projects for EXE or Web browser 
consumption.  If you are setting up a physical touch panel, no additional configuration is 
necessary, simply upload the project to the touch panel. 
 
Open the VT-Pro-e file suitable for your application. 
 
The first step is to choose your compile options.  If you are using Microsoft Vista, compiling 
as an EXE is recommended since X-Panel browser projects are not compatible with Windows 
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Select the Edit menu, then click on Properties. 
 
 

 
 

 
Set your target platform, and make sure the output is set for Release mode. 
 



 

 - 17 - 
Revision 7  

 
 

 
Once you have finished setting up the compile options, click on the Web tab. 
 

 
 
If you are targeting a browser application and plan on uploading the project to the 
processors web-server, set the Control System IP address to 127.0.0.1 and the e-control 
Gateway address to 0.0.0.0 
 
If you are targeting a EXE, or will host a browser application remotely set both address 
fields to the IP address or host name of the Crestron processor. 
 
Click OK to close the Project Properties dialog box. 
 
You can now click on the File menu, and click on Compile.  You can now upload the web 
pages to the processor, or double click on the HTML or EXE file created by VT-Pro-e. 
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Troubleshooting  

Cannot establish a connection with the SoundScope Audio Server. 
 

 Check Server Status in configuration application (step 1).  
necessary. Refer to SoundScope if the server will not report “Running” or if

Stop and restart server if 

the problem persists after reboot. 
 Insure Control Server Port matches Port setting in TCP/IP connection on the 

processor. 
 Insure IP Table is properly populated on the Crestron. 

 
 

No Album Art is displayed. 
 

 Check the Art Server parameter in the SoundScope MCS symbol in SIMPL.  
Make sure the parameter is in the format IPADDRESS:PORT where the IP address 
matches the host computer and the port matches the Web Server port setting in the 
MCS configuration application. (80 by default). 

 Establish a baseline with the Sample VT Pro-e file.  Validate that the analog and 
dynamic art joins have not changed on the thumbnail objects on the VT Pro pages. 

 Isolate the problem by typing http://[host_name]:5005/getart into a browser 
window. (Replace host-   If album art 
for the currently playing media is displayed in the browser, use the Crestron debugger 
to determine what URL the MCE-Now-Playing-Art$ signal is using.  

 
 
 


